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OVERVIEW 

ZaPrompt Pro is comprehensive Dual Screen TelePrompTer Software.  Users can easily import  

text files or create scripts from scratch using the Script Editor.  

 Some of the more advanced features are being able to project formatted text to the Canvas with  

color highlighted, bold, italic, or underlined text.  Users may also choose from their system fonts  

the font style that they want projected to the canvas. 

ZaPrompt Pro was designed for uses by either the keyboard or a remote control with a special  

feature to auto configure the program for a remote.  

ZaPrompt Pro has an easy to use interface that allows users to quickly select how the text will  

scroll on the screen/screens. These controls include:  

 Keyboard Shortcuts  

 Speed Control  

 Smoothness Control  

 Font Size  

 Margin Settings 

 Primary Screen Flip Horizontal or Vertical  

 Secondary Screen Flip Horizontal or Vertical  

 Monitor Test  

 Auto Configure for Remote Control  

The Scrolling Canvas was designed as user friendly as possible.  Once the user sends the script to  

the Canvas the text will begin to scroll according to the settings that they configured in the  

Control Panel.  While the text is scrolling the user has several control and options that can be  

Implemented with the mouse, keyboard, or remote control.  These controls include:  

 Pause/Play/Stop  

 Go To Line  

 Add Bookmarks 

 Increase/Decrease Scroll Speed  

 Increase/Decrease Smoothness  

 Sliding Brackets to center on line to be read.  

At the bottom of the screen the user can see a progress bar that indicates how much of the script  

has ran along with a read-outs on long the script will run in seconds and minutes, what the  

Current scroll speed and smoothness is set at and the how much time is left and how long the  

script has run. 

New to ZaPrompt Pro is the recording Tab that will allow you to program the text to scroll the 

way you want it to.  You can record the way you are playing the text.  ZaPrompt Pro will record 

when you speed up, pause or make any other change to the scroll text in the Scrolling canvas.  

On Playback it will act the same way.
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New to ZaPrompt Pro 1.9 

 

 
 

 

There have been many new features added to ZaPrompt Pro in version 

1.8.  Most of these features have come from request from end users and 

are designed in enhance the overall performance of the program. 

These features include: 

 Resizable Scrolling Canvas on Main Screen. 

 New Speed Scrubber in Scrolling Canvas. 

 New Fast Forward and Rewind keyboard shortcuts. 

 Integration of the Griffin Technology, Inc PowerMate USB 

Multimedia Controller Jog Wheel. 

 New Record and Playback Feature. 

 Improved overall performance of program. 

 

The greatest of all the updates to ZaPrompt Pro is the Record and 

Playback Feature. 

Now Users can record the way that they are scrolling the text in the 

Scrolling Canvas and force it to play back the same way. 

Once the playback has been set the exact way the user wants the script to 

run, every time the script is played back, it will play back the same exact 

way. 

The Next great update to ZaPrompt Pro is the resizable window in the 

main Scrolling Canvas.  Now user can still access the other applications 

installed on their computer while working with the Scrolling Canvas in 

ZaPrompt Pro. 

The Griffin Technology, Inc. PowerMate Jog Wheel adds a whole new 

dimension to ZaPrompt Pro.  With added keyboard shortcuts and 

integration of the PowerMate USB Multimedia Controller the user will 

have full control of the speed and smoothness of the text in the Scrolling 

Canvas. In addition users will have quicker response times to 

adjustments made to speed and smoothness while they are doing live 

scrolls.
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INSTALLATION 

Section 1 

 

Installation 

 

SYSTEM REQUIREMENTS 

PC 2000/XP/Vista System Requirements 

Pentium one or higher Processor 

1 GHz Processor or better 

512 MB of Ram 

47 MB of disk Space 

Note: PC Vista Users need to have OpenGL support installed for their Graphic Card.  See 

Appendix A. 

  

Mac OS X System Requirements 

Mac OS X 10.0 or higher 

512 MB of Ram 

1.0 GHz PowerPC G4 or higher 

47 MB of Disk Space 

 

 

PC INSTALLATION: 

Installation instructions for Windows 2000/XP/Vista. Check system requirements to 

make sure our software will run on your computer.  NOTE: PC Installations require you 

to have OpenGL support installed for your Graphic Card. (See Appendix A) You will 

have to consult your graphic card manufacture for their recompilations and instructions 

on how to install the OpenGL support on your computer. 

1. Insert the Installation CD or Unzip the installation folder downloaded from our 

website. 

2. Locate the Setup.exe file and double click it. 

3. Agree to the terms and conditions and follow the step-by-step installation.  The 

software installer will do most of the work. 

4. Restart your computer before launching ZaPrompt Pro. 

 

 

 

MAC INSTALLATION 

Below are the instructions for installing ZaPrompt Pro on a Mac running OS X 10.0 or 

higher.  See system requirements to see if your computer is compatible with our software. 

To install do the following: 

1. Open the Installation CD or Unzip the downloaded folder. 

2. Locate the ZaPrompt Pro Folder and drag it to your applications folder 

3. Do Not remove any of the files from within the ZaPrompt Pro Application Folder, 

Drag the entire folder to your Mac OS Applications Folder 

4. Restart your Mac before launching ZaPrompt Pro. 
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1.2 REGISTERING ZAPROMPT PRO 
 

When you first launch ZaPrompt Pro a registration dialog box will pop up.  You have three 

choices: 

1. Start the 30 Day Trial 

 To start the 30 day trial click on the trial button and  

 Type “TRIAL” in the activation key text field. 

 

2. Buy a ZaPrompt Pro Serial Number. 

 To buy a ZaPrompt Pro Serial Number click the “Buy Now” button.  You will be 

directed to the ZaPrompt Pro website where you can purchase a serial number that 

can be used to activate ZaPrompt Pro as a fully licensed Program. 

 

3. Activate ZaPrompt Pro. 

 Click the “Activate Button”.  The activation window will open. DO NOT TYPE 

YOUR SERIAL NUMBER INTO THE TEXT FIELD! 

 Click the Blue link that says “Click Here for Key (Must have Serial No.)”. 

 You will be directed to our Safe Activation website. 

 Enter your registration information (name, address, etc.) and in the Request Number 

type the request number that appeared in the activation window of ZaPrompt Pro. 

 In the Serial Number field type the serial number you got when you purchased 

ZaPrompt Pro. 

 Select Submit and an Activation Key will be generated that you can uses to activate 

ZaPrompt Pro on your computer. 

 Go back to the Activation window of ZaPrompt Pro.   

 Type in the Activation Key that you got from the Safe Activation Website and press 

“Activate Now”. 

 Your activation is complete.  Now every time you launch ZaPrompt Pro it will start 

without the Activation window opening up. 
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 GETTING STARTED 

Section 2 
 

This section covers the user interface of ZaPrompt Pro including the menu bar and it’s items, the 

Editing Window is where you will create your scripts and edit them.  

 

Scrip Formatting including color and style, and everything you will need to build a script that to 

be run on the scrolling canvas of ZaPrompt Pro. 

Also this section will cover the control panel where you will configure how your script will 

scroll and how it will be displayed on the monitor/monitors. 

Then we will cover how to scroll your script on the canvas and how to manipulate the speed, 

smoothness and size of the font that is scrolling on the canvas. 

 

 

2.1 The User Interface. 

 

When you first Launch ZaPrompt Pro you will see a window that looks much like a word 

processor (Figure 2.1).  In this window you will see a Menu Bar at the top. Two tabs (Main and 

Controls) near the top and a large black area called the Script Editor. 

 

Figure 2.1 

 
 

Above the Script Editing Window you will see a Text Style Drop down Menu, Text Size Menu, 

an Underline Button , Bold Button, and Italic Button. 

On the Right side of the window you will see four colored boxes. Red, Green, Yellow, and 

White.  These are font color selectors. 
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At the very bottom of the window you will see a long button that says “RUN PROMPT”.  This 

Button is used to start the Scrolling Canvas once you have Prepared you script.  This button is 

only active while text is present in the Script Edition Window. 

 

Menu Bar 

The Menu Bar has four drop down menus File, Edit, Text, Help. In this section we will cover 

what all of these Menu Items Do. 

 

PC  

 

 

 

 

The Menu Items in ZaPrompt Pro were designed to make editing script as easy as possible.  

The File Menu has all the controls for creating new scripts, importing/exporting text files and 

saving ZaPrompt Scripts once you have compiled them. 

Below you will see example of the menu items as they will appear in the ZaPrompt Pro program 

that has been installed on your computer.  You will notice slight differences between the PC and 

Mac versions of the Software. 

 

2.2 File Menu 

File Menu Figure 2.2a 

 

 

 

 

Notice in Figure 2.2a that all of the menu items in the file menu have keyboard shortcuts to the 

right of the command.  For example if you hold down the control key (PC) or command key 

(Mac) and push down the “N” key, the new file command will run without having to select it 

from the menu item. 

 

Below are the menu items for the File Menu and a description of what each of their functions 

are. You will learn more on how to use these commands in Section 3. 

 

New Script - Open new ZaPrompt Script 
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Open Script - Opens a ZaPrompt Script that has already been created 

 

Close Script - Closes the current script and opens a new Script in the Editor Window 

 

Save As - Allows you to save your script as a text file “*.txt“, rich text file “*.rtf“, or                    

  ZaPrompt file “*.zap”.  Save As also serves an export text function. 

 

Save - Saves the current script as a ZaPrompt file 

 

Import Text - Allows you to import text files “*.txt“, rich text files “*.rtf“, or                     

   ZaPrompt files “*.zap”. 

 

Print - Allows you to print the current text in the script editing window.  Read about 

   Printing later in this section. 

 

Exit - Closes ZaPrompt Pro 

 

 

2.3 THE EDIT MENU 

 

Edit Menu Figure 2.3a 

Edit Menu PC  

 

 

 

 

Edit Menu 

The Edit Menu looks similar to the edit menu that you would see in any word processor program 

with the usual text editing menu features. Below is a brief outline of these features.  We will get 

more into editing scripts and using these menu item in section 3.  To the right of the menu Items 

in Figure 2.3a you can see all of the keyboard shortcuts for each of these functions.  Notice that 

the Mac and PC menus are a little different. 
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Undo/Redo - In ZaPrompt Pro the Undo/Redo menu items work similar to those in a word  

     processor.  However, there is one major difference.  ZaPrompt Pro undo/redo can  

     undo or redo quite a bit of text because it only takes frequent snap shops of your  

     script.  Be careful when and how you use this feature. 

 

Cut - Cuts any text that you have highlighted in the Script Editor. 

Copy - Copies any highlighted text to the clip board. 

Paste - Pastes the clip board to the Script Editor Window 

Delete - Deletes text that is highlighted in the Script Editor Window 

 

Select All - Selects all the text in the Script Editor Window 

 

 

Find and Replace function in Edit Menu 

Find.. - Finds words in Script Editor Window 

Find Again - Finds words again in Script Editor Window 

Replace - Replaces words in Script Editor Window with words of your choice 

Replace and Find Next - Finds next word and replaces it. 

 

 

Find and Replace Figure 2.2b 

Find and Replace PC 

 
 

 

2.4 THE TEXT MENU 

 

The Text Menu Item controls that formatting of the text in the Script Editor.  With these controls 

you can color, underline, or make your text italic and/or bold.  This is only one of the way that 

you can do this in ZaPrompt Pro.  Latter on in this section you will learn about the controls in the 

Main Window that will do the same thing.  Figure 2.4a shows the Text Menu for both Mac and 

PC.  Like with all of the other menu items there are keyboard shortcuts to the right of each menu 

item. 
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Text Menu PC 

 
 

 

 

Bold - Toggles bold or not bold on selected text in Script Editor. 

 

Underline - Toggles Underline /no-underline on selected text in Script Editor. 

 

Italic - Toggles Italic or no Italic on selected text in Script Editor. 

 

COLORS: 

Background Color…. – Changes the background color of the script 

 
Text Color…. – Allows you to use color picker to change text color 

 

Red - Changes selected text in Script Editor to Red. 

 

Green - Changes selected text in Script Editor to Green. 

 

Yellow - Changes selected text in Script Editor to Yellow. 

 

White - Changes selected text in Script Editor back to White. 

 

Orange – Changes Selected Text in script Editor to Orange  

 

Blue- Changes Selected Text in Script Editor to Blue  
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Spell Checker – Check and correct spelling in your scripts  

 

2.4 THE HELP MENU 

The Help Menu is a very useful tool for ZaPrompt Pro Users.  The Help Menu has three 

recourses for helping you use and understand ZaPrompt Pro.  

The ZaPrompt Quick Help Viewer, ZaPrompt Online Help, and ZaPrompt.com. 

Below is a description of the Help Menu Items and what they do.  You can see an image of the 

Help Menu in Figure 2.4a. 

 

 

Help Menu Figure 2.4a 

 

 

 

ZaPrompt Help - Launches the ZaPrompt Help Viewer (See Figure 2.4b). 

 

Online Help - Opens help.ZaPrompt.com in web browser. 

 

ZaPrompt.com - Opens ZaPrompt.com in web browser where you can find updates and help. 

ZaPrompt Updates – Directs you to the ZaPrompt Pro Update website. 

 

 

Help Viewer Figure 2.4b 
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2.5 THE MAIN WINDOW 

 

The Main Window contains several things that you will be using in creating a scrip in ZaPrompt 

Pro.  First is the Script Editor which is where you will Open, Import, or Type your scripts. Next 

are the Formatting Controls where you will stylize your script by adding Text Styles, Bold, 

Underline, Italic, and/or colorize your text.   

There are two tabs in the Main Window that will Toggle between the Script Editor and the 

Controls Panel for the program, and finally there is the long button at the bottom of the window 

that start the scrolling canvas. 

In this section you will learn what all these objects are for and how to use them.  You can see an 

image of the Main Window in Figure 2.5a.  You will be working more with the Main Window in 

Section 3. 

 

The Main Window Figure 2.5a 

 

 

 

Main Window PC 17” Monitor 

 
 

 

 

 

 

The Tabs 

There are three tabs on the Main Window, one named “Main” The “Controls“Tab and the 

“Recording” Tab.  These tabs toggle between the Script Editor and the Controls Panel (Controls 

Tab covered later in this section).  You can see an image of the Main Window Tabs in Figure 

2.5b 
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Main Window Tabs Figure 2.5b 

 
 

The Recording Tab will be covered in Section 3 

 

 

 

 

Script Editor 

The Script Editor is the large black area in the center of the Main Window (Figure 2.5a above).  

This is where you will either import your scripts from other applications, or where you will type 

your scripts directly into the text area. 

 

Style and Formatting Buttons 

There are four button above the Script Editor Window they are (Left to Right), Font Style, Font 

Size, Underline, alignment and Italic.  You can also find the controls for Bold, Underline, and 

Italic in the Text Menu on the Menu Bar at the top of the page. You can see an image of these 

controls in Figure 2.5c. 

Style and Formatting Buttons Figure 2.5c 

 

 
 

Color Selectors 

There are four colored boxes on the top right side of the Main Window. These colors are Red, 

Green, Yellow, and White. 

You can change the color of selected text by simply single clicking on one of these colors.  If 

you highlight a world and want it to appear green in the Script Editor and Canvas (See Canvas 

Below) then you simply click on green.  You can also change font color by using the controls in 

the Text Menu at the top of the Main Window in the Menu Bar or by using the color picker tool 

located to the left of the alignment menu. You can see an image of the Color selectors in Figure 

2.5d. 

 

 

Color Selectors Figure 2.5d 

           
 

Quick Help Viewer 

At the bottom right side of the Main Window you will see a large grey Question Mark “?”.  By 

Clicking on the Question mark the ZaPrompt Quick Help will open. 
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Back Ground Color Picker 
New to ZaPrompt Pro is the Background Color Tool.  Now users can not only change the color 

of the Text but now you can change the color of the Background. 

Located below the Script Editor Window you will see a small colored box.  This box is the color 

selection tool for the background of your script.  Click the color selector box and the ZaPrompt 

Pro Color Palet will appear.  Select the color you want and the background will change to this 

color.  You can also access the background color selection tool from the Text Menu. 

Figure 2.5e shows the background color selection tool. 

 

Figure 2.5e 

                    
 

RUN PROMPT BUTTON 

There is a long button at the bottom of the Main Window named “RUN PROMPT”.  This button 

is what will start the scrolling Canvas (See Scrolling Canvas).  This Button is not active until 

there is text in the Script Editor.  When you press this button all of the text and the text 

formatting that you have entered into the Script Editor will be projected on the Scrolling Canvas 

on the computer monitors/displays you have configured in the control panel.  This button is 

visible on both the Main Tab and in the Controls Tab.  

If you want to jump into a Script at the point that the cursor is sitting hold down the Alt/Option 

button while pressing the Run Prompt Button. 

 You can see a image of the button in figure 2.5f. 

 

RUN PROMPT Button Figure 2.5f 
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2.6 THE CONTROL PANEL 

You access the control panel by single clicking on the Controls Tab at the top of the Main 

Window.  The Controls tab is where you will find all the controls that determine how the 

Scrolling Canvas (See Scrolling Canvas) will run. 

There are three main control groups.  Keyboard Shortcuts, Speed Settings, and Display Settings.   

The Keyboard Shortcut settings are located at the top left of the Controls window. There are only 

two of these controls that you can actually change, Scroll Speed and Smoothness.   

In the Speed Controls section you will set up the Scroll Speed which will determine how fast the 

text will scroll on the Scrolling Canvas.  You will set up the Smoothness which will determine 

how smooth the text will scroll.  The smoothness control will allow you to create smooth running 

text, or allow you to have the text stop and start at each line or group of lines.  It takes some 

practice but you can time this perfectly combining both the speed and smoothness. 

Lines Per Screen as exactly what is says.  This determines how many lines of text will be visible 

on the screen that the Scrolling Canvas will be running on.  One of the nicest thing about this 

function is that since it does not use standard font size, but instead lines per screen, you can have 

two different size monitors and they will both see exactly the same thing. 

 

For example, if you have two monitors one 15” and the other 19” both of them will only see 12 

Lines Per Screen if that is what was select in the Control Panel; however the 19” display will 

have larger font obviously.  You can see images of the control panels for Mac and PC in Figure 

2.6a below. 
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Control Panel Figure 2.6a 

 
 

 

 

 

Keyboard shortcuts 

On the top left corner of the control panel you will find the Keyboard Shortcuts control group.  

These controls will run the operations that they are assigned to while the Scrolling Canvas is 

open. There are only two controls that you can actually change, the speed control shortcut and 

the smoothness control shortcut.  There are three other keyboard shortcuts for running the 

Scrolling Canvas; Pause/Play, End/Exit, and Adjust Text Size. In Figure 2.6b you can see an 

image of theses control.  

 

Keyboard Shortcuts Figure 2.6b 
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Pause/Play = Space, Return, mouse click 

Left Margin = L and Shift + L 

Right Margin = R and Shift + R 

Font Size = + and – 

 

Scroll canvas with Mouse wheel: 

Mouse Wheel = 1 line per click 

Mouse Wheel + Alt/Option = 5 lines per click 

Mouse Wheel + Shift = 3 lines per click 

 

Speed: 

Fast Forward = ctrl + arrow 

Double Fast Forward = shift + arrow 

 

Smoothness: 

Fast change = ctrl + arrow 

Double Fast change = shift + arrow 

End/Exit = Esc or End 

Adjust Text Size = +/- 

 

Looping Function: 

Create by marking start point with "(" and jump back point with ")" in "Scrolling Canvas" 

window 

 

Jump to Script Functions: 

Jump to the line you want from the  "Script Editor" by holding down the  Alt/Option button and 

pressing the  "Run Prompt" Button 

 

Speed Control Settings 

On the top right side of the Control Panel you will find three sliders.  They are named; Speed 

Control, Smoothness, and Lines Per Screen. 

These controls determine how the script will scroll in the scrolling canvas.  The Scroll Speed 

control determines the speed, the Smoothness determines the initial smoothness, and the Lines 

Per Screen determine how large the font will appear on the Scrolling Canvas. You can see an 

image of the speed controls in Figure 2.6c. 

Keyboard Shortcuts PC 
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Speed controls figure 2.6c 

 

 
Speed Control - Sets the initial scrolling speed for the Scrolling Canvas 

 

Smoothness - Sets the initial smoothness for the scrolling canvas. By lowering this number you  

     can cause the script to pause at each line or groups of lines. 

 

Lines Per Screen - Sets the initial font size for the scrolling canvas.  The small the number the  

      bigger the font. 

 

Display Controls 

The display controls allow you to set the orientation of the primary and secondary (if used) to 

how you want them to appear once you start the scrolling canvas (Press “RUN PROMPT“).  You 

have the option to flip either display horizontally or vertically, or to not flip them at all.  By 

default neither display is flipped. There is also a button to detect if your computer recognizes that 

it is connected to two monitors.  Figure 2.6d will show you an image of the control.  Appendix B 

covers how to correctly configure the second monitor. 

 

Display Controls figure 2.6d 

 

Display Controls PC  
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Notice that Secondary Monitor button is inactive on the Display Controls for this PC. That is 

because there is only one monitor connected to the computer, therefore the program knows not to 

ask how to manage the second display. 

 

The “Open Scrolling Canvas in Small Window” allows the user to have the Scrolling Canvas 

open half size on the Main Monitor so they can still have access to the other applications on the 

computer while running ZaPrompt Pro. 

 

Primary Monitor - Determines the orientation of the primary monitor.  The primary monitor is  

       the monitor that will be ran on the screen controlled by the ZaPrompt Pro  

       operator. You can flip it horizontally, vertically, or not flip it. 

 

Secondary Monitor - Determines the orientation of the secondary monitor if it is being used.  If  

       you are using a TelePrompTer mirror then you will probably be flipping  

       the secondary monitor horizontally.  The options for this monitor are, flip  

       horizontally, vertically, not flipped or don’t use. 

 

Multiple Display Test - Test to see if your computer detects the secondary monitor. 

 

2.7 ADDITIONAL OPTIONS 

In the Additional Options section of the Controls Tab you will find additional option on how to 

control the Scrolling Canvas like whether or not you want the Scrolling canvas to start paused or 

playing, or if you want the camera lens arrows to be visible or not.  You can also choose to show 

the Primary Monitor window in a smaller windowed mode.  Figure 2.7a shows this part of the 

controls panel. 

 

Figure 2.7a 

 
 

2.8 DEFAULT SETTINGS 

New to ZaPrompt Pro is the Default Settings button in the Control Tab.  Now you can simply 

save the setting of the Control Panel as Default by pressing the button labeled “Default Settings”.  

The next time you open ZaPrompt Pro to create a new script all the settings will be configured 

the way they are set to be as default.  Figure 2.8a show this control. 

 

Figure 2.8a 
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2.9 SCROLLING CANVAS 

There are no differences between the Scrolling Canvas for Mac or PC.  So for this section we 

will only be using images from the PC version of ZaPrompt Pro. 

The Scrolling Canvas is where it all comes together.  Your script, and the controls that you have 

selected in the Control Panel. 

On the primary screen you will notice several things going on in the Scrolling canvas.  First you 

will obviously see the scrolling text, then on both sides you see two Yellow Brackets that can be 

positioned on the line that your want the subject to read.   

Along the bottom starting from left to right you first see a couple buttons.  These buttons are the 

exit and Pause/play buttons. 

Next you see the line counter with a white text box.  You can enter the line you want to jump to 

in the white text box and press the return key on your keyboard.  When you do this the script will 

jump to that line. 

Next you will see the progress bar surrounded with time measurements.  This Progress bar and 

the time measurements tell you a lot about your script.  How long it will run, how far you are 

into the script and how much time is remaining. You can see the main screen at figure 2.9a. 

The secondary screen displays much the same as the primary screen, however one of the operator 

controls appear on the secondary screen.  This screen is strictly for the reader. You can see the 

secondary display in figure 2.9b. 

 

 

Primary Display figure 2.9a  

Scrolling Canvas Primary Screen 

 
This Screen can be flipped horizontally, vertically or not flipped 
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Scrolling Canvas Small Window 

 
 

 

 

 

 

 

 

Scrolling Canvas secondary monitor 2.9b 

 

Scrolling Canvas secondary display with screen flipped horizontally 
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This Screen can be flipped Horizontally, Vertically, or not flipped 

 

The Control Bar 

At the bottom of the scrolling canvas on the primary monitor you will see a long bar that has all 

the controls for the scrolling canvas.  This section covers those controls and how they work. 

 

Exit & Pause/Play - Exit or Pause/Play your script with these buttons.  They can also be   

       controlled by the keyboard with the shortcuts from the Keyboard Shortcuts  

       in the control panel. Figure 2.9c 

 

Figure 2.9c Exit , Pause Play & Record buttons 

     
 

 

Lines Counter - The line counter displays the current line of text in a white text box followed  

      by the total number of lines.  You can jump to any line in your script by  

      entering the line you want to jump to in the text box and pressing the enter key  

      on your keyboard.  Figure 2.9d show an image of this control. 

 

Figure 2.9d Line Counter 

 
 

Enter line you want to jump to in text area and press enter. 

 

 

 

 

Progress Bar - The progress bar is a very helpful tool when you are running a script in the  

      Scrolling Canvas.  From left to right you will first see the Scroll Speed and  

      Smoothness settings.  You can increase or decrease these values using the  

      keyboard shortcuts while the script is scrolling.  Next you see a progress bar that  

     has three time measurements associated with it.  To the left is the Time in or  

      how long the script has been running, and on the right is the Time Out which is  

     how much time is left for the script to Run. Underneath the Progress bar you will  

     see how long the script will run at the current speed. Finally the Progress bar it  

     self shows an orange bar that indicates how far you are into the script. Figure  

     2.9e has an image of what this control looks like. 

 

Figure 2.9e The Progress Bar 

 
 

Increase or decrease Scrolling Speed or Smoothness with the arrow keys on your keyboard. 

 

2.10 BOOKMARKS 
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New in ZaPrompt 1.6 is the advanced Bookmark tool.  This tool is found on the tool bar at the 

bottom of the Scrolling Canvas between the Lines Counter and the Progress Bar. Figure 2.10a 

show an image of the Bookmark tool. 

Figure 2.10a 

 
 

To use the Bookmark tool simply play your script or enter the line number in the Line 

Counter text field (then hit the return key) and locate the point in your script where you 

want to add a Bookmark. 

Once you have located the position left click on the Bookmark Icon. 

 
 

 

The Bookmark Pop-up window will open.  There are ten positions you can save in your 

script using the Bookmark tool.  Each position is assigned a number.  The number it is 

assigned is a keyboard shortcut.  To navigate to any of these positions simply press the 

corresponding number on the keyboard or select it from the pop-up menu. 

 

To create a Bookmark select the Add Bookmark… option in the pop-up menu.  A dialog 

box will open. 
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Type the name you want to uses to identify this Bookmark and select the number key that 

you want to associate with it.  Select “OK” and the Bookmark is created.  If you select the 

Bookmark Icon again you will see that the Bookmark has been added and that the number 

2 position has been used. 

Once you have created all the Bookmarks you want in your script, you may find the need to 

edit or change them.   

This can be done vary easily by selection the Bookmark Icon and Selecting the Edit 

Bookmark… Option. 

 
 

A new dialog box will open where you can move or delete any one of the Bookmarks. 
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You can change the position and the keyboard shortcut to a Bookmark by selecting the up 

or down buttons.  This will move the Bookmark to the next available slot. 

If you want to remove a Bookmark, select it from the list field and select the delete button. 

 

 

 

 

 

 

 

2.11 PRINTING SCRIPTS 

Now it is time to back up a little bit.  Now that you understand the User Interface of ZaPrompt 

Pro you are almost ready to begin creating scripts for yourself.  One last subject in this section is 

on printing scripts. 

Since you are creating your scripts in the Script Editor you will be typing/importing white text on 

a black background.  If you were to print your text like this you would use a lot of printer ink. To 

prevent you from having to do this your script will be opened in a new window with a white 

background and black text so it can be printed. 

The window will open using the font size and style selected in the Script Editor window styled 

text drop down menus. 

If you want a smaller/larger font to be printed change the font size before proceeding to print 

your document.  Figure 2.9a shows an image of what the printing window looks like.  To print a 

ZaPrompt Pro script, in the Menu Bar select File > Print.  Once the window opens press Print 

and your Script will print.  When you’re done press close to return to the Script Editor Window. 

 

 

Print Script Window figure 2.11a 
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Print Script Window PC 

 

 

 

 

 

 

 

Section 2 End 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

24 

THE RECORDING FEATURE 

SECTION 3 
 

The Recording Feature is new to ZaPrompt Pro.  The purpose of this feature is to allow the user 

to record the speed of the Scrolling Canvas during a live scroll so it can be played back at a later 

time the exact same way. 

The easiest way to use this feature is to simply press the record button in the Scrolling Canvas 

while the text is scrolling. 

Figure 3.a show the record button both active and inactive. 

 

Figure 3.a 

     
 

While the record feature is active the Record Button is Green and while it is inactive the button is 

Grey. 

When using this feature you will use the Scrolling Canvas much as you would during a live 

session, in fact, you could be recording during a live session or a practice session. 

Whenever you speed up or slow down the scrolling text, the change is recorded in the Recording 

Tab on the main window. 

Figure 3.b shows the recording tab after a few changes have been recorded. 

Figure 3.b 

 
 

There are three columns in the Recording Tab record area the are POS (Position), Event (What is 

being recorded), and Nearby Script Text (Text nearest to the point the change was recorded). 

 

You can fine tune the recording by selecting the event.  You have the option to change the speed 

at that event or create the script to pause for any given amount of time. 
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Figure 3.c illustrates the recording editing tools in the Recording Tab Panel. 

 

Figure 3.c 

 
 

 

There are three buttons along the bottom of the Recording Panel that will help you control the 

recording.  The first is “Insert Event”. This function will create an Event at the point you were in 

the script when you exited the Scrolling Canvas.  The best way to use this feature is to play the 

script to the point where you want to make a change to the speed of the script and select the 

pause button.  Then Exit the Scrolling Canvas, now when you Insert an Event into the Recording 

Panel it will be where you want it. 

 

The next button is the “Delete Event” button.  This button will allow you to delete an event in 

case you have made a mistake in how you want the Script to scroll at any given point, or if you 

want to omit a speed change at a certain point of the script. 

 

The next button is “Clear All”.  This button will clear all of the recorded changes to the speed.  

This is useful if you would like to start over. 

 

Figure 3.d shows the three buttons mentioned above. 

 

Figure 3.d 

 
 

 

Once you have recorded the script it is time to play it back.  In the Recording Panel there is a 

“Play Back” check box.  If this box is checked the text will play back using the recorded speed 

changes in the Recording Panel. 

Play Back Button 

 
Now by pressing the “Run Prompt” button you are telling the ZaPrompt Pro that you want to use 

the recorded speed setting to play back the text. 
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The Scrolling Canvas has a control at the top left corner of the screen that looks like a clock that 

is only visible during playback. 

Figure 3.e shows this control. 

Figure 3.e 

 
 

If you make a manual change to the speed of the Scrolling Text in the Scrolling Canvas during 

playback, the playback control is disabled and a red line will appear through the center of the 

clock, text will also appear across the screen telling you that you have disabled the playback. 

To resume the playback simply click on the clock at the top left corner of the screen.   

Playback will resume until you make another change, click on the clock again, or until the 

playback has reached the end of the recording. 

 

JUMP TO/ LOOP FEATURE 

New to ZaPrompt Pro is the Jump To or Loop Feature in the Recording Tab.  Now you can 

create a new event and select Jump To from the event type drop down menu.  Then select the 

percentage of the Script that you want to jump  back to.  This feature is very useful if you need to 

loop an entire script or if you need to only loop a small section of the script.   IMPORTANT: 

There is one gotcha in associated with this feature.  If you are using the Alt/Option + Run 

Prompt function to start the scrolling canvas.  These loop settings will cause the script to jump 

back to the beginning of the loop.  This is normal behavior for ZaPrompt Pro.  So be advised that 

if you are using the Alt/Option + Run Prompt function to start the Scrolling Canvas you must 

take into account that you will need to disable the loop or completely disable the playback mode. 

Figure 3.f is an image of the jump to feature of the Recording Tab. 

 

Figure 3.f 
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CREATING YOUR FIRST SCRIPT 

Section 4 

 
Now that you are familiar with the user interface of ZaPrompt Pro it’s time to put it all together.  

In this section your are going to see an example of a script put together, the controls set, and the 

scrolling canvas put to use. 

A Mac version of ZaPrompt Pro will be used to create this example, using two monitors with the 

second monitor reflecting off of a TelePrompTer Mirror. 

To keep it simple you will be importing the Example .rtf file located on the installation disk for 

ZaPrompt Pro. 

 

4.1 BUILDING THE SCRIPT 

 

Open ZaPrompt Pro if you haven’t already and do the following: 

1. On the Menu Bar at the top of the page select File > Import Text. 

2. Locate the Sample_RTF.rtf file on the installation disk or in the download folder. 

3. Select and click open. 

 

You will notice that the text imported in a very small font.  To increase the font size select the 

font size drop down menu above the Script Editor and select 26 points for the font size. 

 

 
 

 

 

 

 

 

 

 

 

 



 

28 

 

 

 

Now that you have the text loaded in the Script Editor lets change it ALL to bold and change the 

font to Arial Black. 

1. In the Edit menu at the top of the page find and select “Select All”. 

2. In the Text menu find and select Bold 

.  

3. Hold down the command button (control button on PC’s) and press the A button on your 

keyboard to select all the text again. 

4. From the font style drop down menu above the Script Editor locate Arial Black and 

select it. 

 
 

Now place your pointer anywhere in the Script Editor and single click to deselect the text. 
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Lets add some color highlights to the first paragraph of the script. In this example we will use all 

three ways to add color to a script. 

 

 

Hold down the left mouse button and drag over George Washington in the first line of text.  

 

 
 

Single click the Red box in the color selector above the script editor.  

 

 
 

Now hold down the left mouse button and drag over the words Federal Hall in the second 

line to select it. 

 
 

From the Text menu select Green.  

 

 
 

In the first line of the second paragraph select Born in 1732 by placing the cursor in front of 

the first letter, holding down the shift key and pressing the right arrow key until it is all 

selected.  
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Hold down the command key and press the Y key to change the selected text to Yellow.  

 

 
 

 

4.2 SETTING UP THE CONTROLS 

 

Now that you have created the script it is time to prepare it to be projected onto the Scrolling 

canvas.  To do this you will need to select the “Controls” tab at the top of the page to open the 

Control Panel. 

 

 
 

Once the Control Panel is open we can set up the initial controls for how the Scrolling Canvas 

will open.  Once the Scrolling Canvas is running you can use the Keyboard Shortcuts to adjust 

these controls. 

 

1. First set the Keyboard Shortcuts.  For this lesson we will set the Speed Control shortcut to be 

    the up and down arrows on the keyboard. 

 

 
 

2. Now lets set the Scrolling Speed by moving the slider to 31. This is how your script will start 

    to scroll once you press the “RUN PROMPT” button. 

 

 
 

3. We don’t want the Scrolling Script to pause at each line so we will set the smoothness to 100.  

    This will create a nice even smooth scroll. 
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4. For the Lines Per Screen we want to have a medium size font so we will set this to 15.  The  

    smaller this number the larger the font will appear on the scrolling canvas. 

 

 
 

5. Next we will set the orientation of how the Scrolling Canvas will appear on each display.  We  

    will leave the Primary monitor “Not Flipped” and we will set the Secondary Monitor to “Flip  

    Horizontally now when we start the Scrolling Canvas the Primary Screen will look normal    

    and the Secondary Screen will be flipped. 

 

 
 

 

4.3 STARTING THE SCROLLING CANVAS 

 

Now that we have created the script and have set all the controls the way we want them, it is time 

to put it all to work.  

 

1.  To start the scrolling press the “RUN PROMPT” button at the bottom of the ZaPrompt  

     Window. 

 

 
 

 

 

The scrolling canvas will open and the script will start scroll. 
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While the Script is running you can use the controls at the bottom to speed up, slow down, or 

pause/play or exit the script. 

 If you want to jump to any line in the script you can simply type the line number in the text 

area at the bottom of the screen and press the return key. 

 To increase or decrease the font size press the - or + arrow on your keyboard. 

 Once you are finish simply press the red X at the bottom left side of the screen and the 

canvas will close. 

 

 

 

You have completed the Example Lesson
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APPENDIX A 

OpenGL Support for Window Graphic Cards 

 

ZaPrompt Pro for windows requires that your graphic card has OpenGL support.  Below is the 

definition of OpenGL. 

 

OpenGL (Open Graphics Library) is a standard specification defining a cross-language 

cross-platform API for writing applications that produce 2D and 3D computer graphics. 

The interface consists of over 250 different function calls which can be used to draw 

complex three-dimensional scenes from simple primitives. OpenGL was developed by 

Silicon Graphics Inc. (SGI) in 1992[1] and is widely used in CAD, virtual reality, 

scientific visualization, information visualization, and flight simulation. It is also used in 

video games, where it competes with Direct3D on Microsoft Windows platforms (see 

Direct3D vs. OpenGL). 

 

If your computer is experiencing problems with the Scrolling Canvas it is probably due to 

the fact that the current graphic card driver that you are using does not support OpenGL. 

 

To locate and install the OpenGL driver for your graphic card do the following: 

Find out what graphic card is installed in your computer by doing the following 

1. Windows 2000/XP right click on the start menu 

a. Left click on my computer 

b. Right click on properties 

c. Once the System Properties window opens select Hardware 

d. Click on Device Manager 

e. Locate Display Adaptor and expand it 

f. The name of your graphic card should appear, it will look something like 

“NVIDIA GeForce 6100” 

2. Windows Vista Do the Following: 

a.Right click on the start menu 

b.Left click on Computer 

c. In the task bar select Device Manager 

d.Locate Display Adaptors and expand it 

e. The name of your graphic card should appear, it will look something like “NVIDIA 

GeForce 6100” 

 

Once you know the type of graphic card that is installed in your computer Google search for 

the contact information of the manufacture of the card. 

Go to their website and locate the download driver section. 

Download and install the most current driver .   

OpenGL support should now be installed for your graphic card.

http://en.wikipedia.org/wiki/Cross-platform
http://en.wikipedia.org/wiki/Application_programming_interface
http://en.wikipedia.org/wiki/2D_computer_graphics
http://en.wikipedia.org/wiki/3D_computer_graphics
http://en.wikipedia.org/wiki/Geometric_primitive
http://en.wikipedia.org/wiki/Silicon_Graphics
http://en.wikipedia.org/wiki/OpenGL#cite_note-0
http://en.wikipedia.org/wiki/Computer-aided_design
http://en.wikipedia.org/wiki/Virtual_reality
http://en.wikipedia.org/wiki/Flight_simulator
http://en.wikipedia.org/wiki/Video_games
http://en.wikipedia.org/wiki/Direct3D
http://en.wikipedia.org/wiki/Microsoft_Windows
http://en.wikipedia.org/wiki/Comparison_of_OpenGL_and_Direct3D
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APPENDIX B 

Setting Up Second Monitor 

 

 

 

SETTING UP THE SECOND MONITOR 

 
When using a second monitor it is important that it is configured correctly.  In this section you will learn how 

to configure the second monitor on Windows 2000/XP/Vista and Mac OS X.   

There are two main ways to set up a secondary display, the first is to simply mirror the 

desktop and the other is to extend the desktop into the second monitor. 

To configure the secondary monitor correctly for ZaPrompt Pro you want to extend the 

desktop into the second monitor. 

 

PC Laptops 

If you are using a PC Laptop you can usually do this by holding the function key and 

pressing the F9 key.  Every time you press the F9 key while holding down the Function key 

a different multiple monitor option will appear.  Select the option that uses both monitors 

and extends the desktop into the second monitor.  If you are still seeing the Exact same 

thing in both monitors go to the next step and follow the instructions. 

 

Windows 2000/XP/Vista Desktop Computers 

For the above three Window Operations Systems extending the desktop into the second 

monitor is done basically the same way. 

 

1. Left Click anywhere on the desktop, a menu will pop-up.  Select Properties on 

Windows 2000/XP or Customize on Windows Vista (then select properties). 

2. Once the Properties window opens select the Settings tab. 

3. In the settings tab you should see both of your monitors.  Select the second monitor. 

4. Uncheck This is my primary monitor 

5. Check Extend the Desktop onto the monitor. 

6. Select Apply 

7. Select Close 

 

On Mac OS X setting up the second display is a lot easier than a PC.  There are only a 

couple steps that you need to follow. 

 

1. Open System Preferences 

2. Select Displays 

3. Select Arrange 

4. Make sure Mirror displays is not selected 

5. Close System Preferences 

 

 

If your computer does not select the second display make sure that the display is plugged 

into the power and that it is connected to the computer.  Also make sure that the power is 

turned to the secondary monitor. 

 

If for some reason your second display cannot be detected by your computer consult the 

owners guide that came with the computer that you are trying to connect to a second 

monitor. 
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APPENDIX C 

Controllers 

 

 GRIFFIN TECHNOLOGY POWERMATE CONTROLLER 

 

There are two support controller options for ZaPrompt Pro The first is the Griffin Technology 

PowerMate USB Controller. 

This is a Jog wheel that sits near to the operators computer and is plugged into a USB Port.  This 

controller can be configured to control the Speed and pause/play function of the Scrolling 

Canvas ONLY. 

To use this controller you need to install the most current driver for the PowerMate from the 

Griffin Technology website at http://griffintechnology.com. 

Below are some guidelines on how to configure the Griffin Technology PowerMate driver to run 

ZaPrompt Pro. 

 

1. Install the drivers that came with your Griffin Technology PowerMate USB 
Multimedia Controller. 

2. Plug-in your PowerMate 
3. If it is not already open select Start > All Programs > Griffin Technology > 

PowerMate > PowerMate on a PC, or System Preferences > PowerMate on a 
Mac. 

4. Select the "+" button at the bottom of the Applications window and locate 
ZaPrompt Pro. 

5. Once ZaPrompt Pro appears in the Application Panel, select it. 
6. You will see six Action functions for the Jog Wheel.  Select the "turn Left" Action 

and in the Type Column select "Send Keys".  In the Keys: text box press the "Up 
Arrow".  Now, Select the "Turn Right" Action and in the Type Column select 
"Send Key". In the Keys: text box press the "Down Arrow".  Now the Jog wheel 
is configured to increase and decrease the speed of the scrolling text. 

7. You can configure the "Press + (turn Left, and Turn Right)" to do fast forward 
and fast rewind by using the "Shift + Arrow Key" combination in the Keys: text 
box. 

8. Now you will set the "down" Action to "Pause" the script and the "down and 
hold" Action to "Exit the Script".  To do this set the down Type to Send Key and 
in the Keys: text box press the "space bar".  In the "Down and Hold" Type, select 
Send Keys again and in the Keys: text box select the "End" Key. 

 
PowerMate is a product of Griffin Technology, Inc and has no affiliation with Gilbert and 
Company Inc. or ZaPrompt Pro.  Griffin Technologies has made no claims or warranties 
regarding the use of their products with ZaPrompt Pro. For more information visit 
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griffintechnology.com or contact Griffin Technologies at Griffin Technology, 1930 Air 
Lane Drive,Nashville, TN 37210.  Gilbert and Company Inc. makes no claims of 
ownership or affiliation with Griffin Technology, Inc. or any of it's products. 
 

 KEYSPAN WIRELESS PRESENTATION REMOTE 
 
The second Controller is the KeySpan Presentation Bluetooth remote.  This remote is 
perfect for users that do not have an operator for the software and for users that want 
to control ZaPrompt Pro from a distance. 
This is a plug-and-play controller.  Simply plug it in and it works.  This controller will 
control the speed with the toggle on the side of the remote and the mouse to control 
the rest of the program can be run by the mouse controller on the device.    
To configure ZaPrompt Pro to work with this remote you need to do the following: 

In the ZaPrompt Pro controls Tab locate the keyboard shortcuts and switch the 
speed controller to be the Left and Right Arrow Keys and the Smoothness to be 
controlled by the up and down arrow keys. 


